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What is OOG?
OOG, The Object Orientation Game, by MCM Productions is the first to present 4 different tiling puzzle 
games in a single shareware application.    OOG challenges you to try and solve the tiling puzzles of 
Tangrams, Pentominoes, Hexagons and Polyominoes.    Each of these games has the same set of 
features and is played using the same easy-to-use interface.    Learn how to play one and you've learned 
how to play them all.

All of the puzzles found in OOG are solved by arranging a given set of shapes to completely overlay, or 
cover, a displayed puzzle outline.    The solution to a puzzle must not, and will not, contain any overlap 
between these shapes.    The shapes can be moved, rotated or flipped using simple mouse operations.    
After a shape has been moved, OOG automatically snaps it to it's closest neighbor giving you perfectly 
aligned and connected shapes every time.

One of OOG's most exciting features is the ability to create your own puzzles.    These puzzles can then 
be saved to disk and exchanged with other users of OOG.    Also, if you are having trouble solving a 
puzzle, you can ask for a hint, ask to see the solution, or you can save your progress on the puzzle so 
you can try again later.    And when you finally find a solution to a puzzle, OOG recognizes it automatically 
and rewards you with a fanfare of raining confetti.

OOG's built-in player progress tracking feature can be used to remember which puzzles you've solved for 
each game.    OOG allows you to set the color of screen items and provides several different puzzle 
selection methods including Auto-Advance, Select By Number and Select By Picture.    OOG, The Object 
Orientation Game, comes complete with a Windows Help file documenting all available features.    The 
registered version includes over 300 puzzles.

Follow this link to learn how to play OOG.

Key Features
Here is a quick list of some of the major features of OOG and links to their descriptions.

· Tangrams, Pentominoes, Hexagons & Polyominoes all in a single application
· Automatically determines when you've found any solution to a puzzle
· Automatic snapping, or alignment, of the game pieces to each other and the puzzle outline
· Create your own puzzles that can be saved to disk and exchanged with others
· Save your progress on a puzzle so you can try again later
· All game play operations are performed using a two or three button mouse
· Player progress tracking remembers which puzzles you've solved for each game
· Animated hints and showing of the solution, even for puzzles you create yourself
· Ability to change the color of the game pieces and the puzzle outlines
· Puzzle selection methods include Auto-Advance, By Number and By Picture
· A complete Windows Help file describing game play and all features (you're reading it!)

MCM Productions hopes you enjoy playing OOG. We enjoyed developing it for you!



What are polyform puzzles?
The tiling puzzle games found in OOG are more commonly referred to as polyform puzzles by puzzle 
enthusiasts.    The goal of a polyform puzzle is rather simple to understand.    (It is usually the solution 
that causes all the problems.)    Your goal is to arrange a given set of shapes to completely overlay, or 
cover, a given puzzle outline.    The resulting solution must not and will not contain any overlap amongst 
the shapes.    Note that many polyform puzzles have more than one solution.

While the premise behind polyform puzzles may sound rather simple, finding the solutions can be very 
challenging...and frustrating.

The shapes, or game pieces, for a given polyform puzzle usually all have something in common.    Each 
game piece is typically composed of one or more copies of a base shape or shapes.    For instance, 
each game piece found in the Pentominoes polyform consists of a different combination of 5 equally sized
squares.    So the base shape for pentominoes is the square.    Can you determine the base shape for the 
other polyforms found in OOG?

This version of OOG contains the following popular polyforms:

Tangrams
Pentominoes
Hexagons
Polyominoes

Learn How to Play OOG



The Tangrams Polyform
Tangrams is an ancient Chinese puzzle consisting of the 7 game pieces shown below.

The base shape for Tangrams is an isosceles right triangle.    The two smallest triangles are an example 
of the Tangrams base shape.    All of the remaining shapes are formed by combining multiple copies of the
base shape.    The medium sized triangle, the square and the parallelogram are each composed of two of 
these small triangles.    The large triangle is formed by combining two medium sized triangles or four small
triangles.

The Tangrams polyform can be played via a selection on the Switch Menu.    Click here for a description of
all the polyform puzzles found in OOG and follow this link to learn how to play.



The Pentominoes Polyform
Pentominoes is a very complex polyform consisting of the 12 game pieces shown below.

The base shape for Pentominoes is a square and the game pieces represent the 12 unique combinations 
for arranging a group of 5 equally sized squares edge to edge without duplication.

The Pentominoes polyform can be played via a selection on the Switch Menu.    Click here for a 
description of all the polyform puzzles found in OOG and follow this link to learn how to play.



The Hexagons Polyform
Hexagons is a very complex polyform consisting of the 10 game pieces shown below.

The base shape for Hexagons is, oddly enough, a hexagon.    There are 3 game pieces consisting of 3 
equally sized hexagons and 7 game pieces consisting of 4 equally sized hexagons.

The Hexagons polyform can be played via a selection on the Switch Menu.    Click here for a description 
of all the polyform puzzles found in OOG and follow this link to learn how to play.



The Polyominoes Polyform
Polyominoes is a very complex polyform consisting of the 12 game pieces shown below.

The base shape for Polyominoes is a square.    Each game piece is formed by combining multiple equally 
sized squares edge to edge.    The smallest game pieces consist of 4 equally sized squares while the 
largest is formed using 7 squares.

The Polyominoes polyform can be played via a selection on the Switch Menu.    Note that this polyform 
puzzle is only available to registered users of OOG.    Click here for a description of all the polyform 
puzzles found in OOG and follow this link to learn how to play.



How to play OOG
Inorder to solve the polyform puzzles presented by OOG, you must be able to manipulate the given set of 
shapes, or game pieces.    There are only three operations necessary for performing this task and all are 
performed using either a two or three button mouse.    Note that you will be using these exact same 
operations when you create your own puzzles.

For each of the shape operations listed below, the cursor must be inside the shape you wish to 
manipulate prior to starting the selected operation.    A detailed step-by-step explanation of each of these 
operations is given below.

Shape Operation Mouse Operation
Move a shape Left Button Click + Drag
Rotate a shape * Right Button Click + Drag
Flip (or mirror) a shape ** Left+Right Button Click

* Rotating can be configured to work using just a single right button click.    See below.
**This operation can also be performed using the middle button of a three button mouse.

Upon completion of any of these operations, OOG makes a decision about where you were attempting to 
place the shape and automatically snaps the shape to its closest neighbor.    Once snapping is complete, 
OOG checks to see if the puzzle has been solved.    If the puzzle has been solved...well, you'll see.

Follow this link for more information about solving of puzzles.
Follow this link if you're interested in learning more about the OOG snapping algorithm.

Moving a Shape
Perform the following steps when you wish to move one of the game pieces:

· place the mouse cursor over the shape you wish to move
· press and hold the left mouse button
· the shape will change to an outline
· drag the shape outline to the desired location
· release the left mouse button
· the shape will change back to being fillled-in

Rotating a Shape
Depending on how you've configured the rotate operation for the current polyform, rotating a game piece 
is performed using one of the following two procedures:

Procedure #1 - Right Click and Drag
· place the mouse cursor over the shape you wish to rotate
· press and hold the right button
· the shape will change to an outline
· the point of rotation will be highlighted by a small circle on the shape
· the cursor will change shape to indicate how the mouse should be moved
· move the mouse in a circle about the point of rotation on the shape
· notice how the cursor changes shape as you rotate to help guide you along
· release the right mouse button
· the shape will change back to being filled-in

Procedure #2 - Right Click
· place the mouse cursor over the shape you wish to rotate
· press and then release the right mouse button



· the shape will rotate in the clockwise direction by the configured angle
· to rotate in the counter-clockwise direction, hold down the CTRL key while clicking the right 

mouse button

Note of Caution: If you are trying to solve a puzzle and find you are having trouble getting a shape to 
rotate into the desired position, check your current rotation angle selection.    It is possible that with your 
current selection you will be unable to get the shape to the position you want.    To overcome this problem,
simply set the rotation angle to 15 degrees.    Since this is the smallest allowable value for the rotation 
angle, any shape rotational position can be achieved using this setting.

Flipping a Shape
Perform the following steps when you wish to flip a game piece on its back:

· place the mouse cursor over the shape you wish to flip
· press and then release both the left and right mouse buttons, or
· press and then release the middle button of a three button mouse

Flipping performs differently depending on which shape is being flipped.    There is no easy way to 
describe how shapes are flipped that would explain all possible cases.    We recommend you experiment 
with each shape in a given polyform.    It is important to note that not all shapes can be flipped as the 
flipping of some shapes in no way changes their orientation on the screen (ie. the square in Tangrams).



What's New in this Version
The following list highlights the major new features available with this version of OOG.    The list also 
details some of the changes or fixes that were incorporated into OOG since the last release.    A less 
wordy but more complete list can be found on our Revision History page.    Follow the links in the 
paragraphs below for even more detailed information about the appropriate topic.

Association of Shareware Professionals
MCM Productions is now proud to be an Author Member of the Association of Shareware Professionals.    
As a result of this, the help file and related text documents were updated to reflect our membership status
and the offical ASP Ombudsman Statement has become a part of our documentation.

File Preview Window
A file preview window was added to both the Load Puzzle and Restore Layout dialog boxes.    These 
windows, which are located directly below the OK and Cancel buttons, allow you to visually preview the 
contents of a selected file before the action is performed.

Puzzle Statistics Dialog Box
The new Puzzle Statistics dialog box, available from the Options Menu, allows you to see and manipulate 
the contents of your player progress tracking database for the current puzzle game.    You can change the 
solve status of any of your puzzles as well as see how many total puzzles you have currently solved.

Delete Player Function
The Delete Player button was added to the New Player dialog box to allow you to delete a player that was
being used to maintain a player progress tracking database.    You can now remove player's that you no 
longer wish to be in the list.

Setup Options
The Options Menu now has two separate dialog boxes available for configuring game play.    The General 
Setup dialog box allows you to configure settings that affect the general operations of OOG.    The new 
Game Setup dialog box allows you to configure items that apply only to the specific puzzle game you are 
currently playing.    Features available in this dialog include the ability to prevent the snapping of game 
pieces to the puzzle outline and a new method for performing shape rotations requiring a single mouse 
button click.

More Puzzles
With this release we have added several new puzzles to our already large collection.

Algorithm Fixes
A couple of the algorithms found in OOG had some minor flaws in the previous release that required 
some fixing.    Specifically, we corrected problems in the algorithm used to determine when a puzzle was 
solved and in the algorithm used to build the puzzle outline from user created puzzles.    If you're 
interesetd in more information, read our Algorithm Notes page.

Other Changes Worth Mentioning
These changes are somewhat minor in nature but are still worth mentioning.    After solving a puzzle, you 
will be required to hit a key on the keyboard or click a button on the mouse before you can continue.    
This was done to give you time to admire your solution to a puzzle before you were forced to make a 
decision about what you wanted to do next.    Also, the scheme used on the By Puzzle dialog box to 
indicate if a given puzzle has been solved was changed slightly.



Some notes about solving puzzles
The goal of a polyform puzzle is to arrange the given set of shapes to completely overlay, or cover, the 
displayed puzzle outline.    The resulting solution must not and will not contain any overlap amongst the 
shapes.    The majority of the puzzles found in OOG have more than one possible solution.    OOG 
automatically detects whenever you solve the current puzzle no matter which solution you happen to find. 
You are even free to solve the current puzzle anywhere on the playing field.    You do not have to align the
game pieces with the puzzle outline inorder for OOG to detect that you have solved the puzzle.    Even if 
you create your own puzzles and give them to a friend, OOG will automatically detect their solutions to 
your puzzle no matter which one they find.    Even if it has more than one solution and you didn't even 
know it.

If you find yourself frustrated while trying to solve a particular puzzle, you can always save your current 
layout to disk and take a break.    Then at a later time, you can restore your work and try again.    If you get
really frustrated, you can always ask for a hint or ask to see the solution.

Once you have solved a puzzle, OOG will perform the "game over" fanfare according to the settings in the
General Setup Dialog Box and then update your player progress tracking data.    You will then get to 
review your solution while OOG waits for you to click a mouse button or press a key on the keyboard.    
After that you will be presented with one of the following two message boxes.

After Solving a Built-In Puzzle
After solving one of the puzzles built into OOG, you are presented with a dialog box with 3 push buttons.   
Select the first button to advance to the next puzzle in the sequence.    The second button gives you a 
chance to continue reviewing your solution.    Choose the third button if you would like to save your 
solution to disk using the save layout feature.

After Solving a Puzzle Loaded from Disk
After solving a puzzle that you have loaded from disk, you are presented with a dialog box with 3 push 
buttons.    Select the first button if want to load another puzzle from disk.    The second button gives you a 
chance to continue reviewing your solution.    Choose the third button if you would like to save your 
solution to disk using the save layout feature.



What is player progress tracking?
The player progress tracking feature gives OOG the ability to remember which puzzles a player has 
solved for a particular polyform.    Whenever you play, a database is being maintained that is used to store
which puzzles have been solved for the current polyform.    When you solve a puzzle, the database is 
updated to identify that that particular puzzle has been solved.    This is something OOG does 
automatically.    You can not turn this feature off.    However, you can decide whether the player progress 
database is maintained for just the current game session or whether it is saved to disk where it can then 
be restored the next time you play.    You can configure this option using the New Player Dialog Box.

Note that the player progress tracking feature only stores the "solved status" information about the 
puzzles built into OOG.    It does not maintain any information for the puzzles you create and then load in 
from disk.

The solved puzzle data in the player progress database is also used by the following OOG features.

Advance to the Next Puzzle
Select a Puzzle By Number
Select a Puzzle By Picture



The OOG Snapping Algorithm
Snapping is the catch phrase used to describe the operation performed by the OOG auto-shape 
alignment algorithm.    The snapping algorithm is invoked at the conclusion of every shape maneuver 
operation (i.e. move, rotate or flip) and its purpose is to "guess" at the intended location of the shape 
relative to its neighboring shapes and/or the puzzle outline.    Once the algorithm has made its decision, it 
snaps the shape to the selected location thereby freeing the player from having to worry about perfectly 
aligning the game pieces along side each other.

Why Should I Care About The OOG Snapping Algorithm?
You do not need to understand anything about this algorithm inorder to enjoy solving and creating 
polyform puzzles with OOG.    It is expected that the majority of users will not need to concern themselves
with this topic at all.    The only time you might be interested in the operation of the snapping algorithm is 
when you are creating your own polyform puzzles.    When you are creating puzzles, there are menu 
items available that allow you to change the behavior of this algorithm.    (More on this below.)

How Does Snapping Work?
As you will notice from the examples given below, the snapping algorithm deals only with the positional 
alignment of the game pieces.    It will only translate, or move, a game piece in the horizontal and/or 
vertical direction when performing a snap.    It does not do any rotational alignment of the shapes.    The 
snapping algorithm is capable of performing any one of the following types of snaps.

Snapping a point to another point (P2P)
Snapping a point to a line (P2L)
Snapping a line to a point (L2P)

The type of snap performed after a shape has been manipulated depends on whether you are solving or 
creating puzzles.    P2P snapping is the only type of snapping performed by the algorithm when you are 
solving puzzles.    You can not change this.    This type of snapping occurs between the game pieces and 
between the game pieces and the puzzle outline.    It is possible to configure the current polyform such 
that when solving a puzzle, P2P snapping only occurs between the game pieces and not between the 
game pieces and the puzzle outline.    For more information, see the Game Setup Dialog Box.

However, when you are creating puzzles the algorithm can be configured, at any time, to perform any 
and only one of the snap types listed: P2P, P2L or L2P.    You can select which type of snap is performed 
by the algorithm using the OOG Quick-Click Menu.    This menu is accessed by clicking the right mouse 
button on the window background while creating your own puzzles.    Simply select the type of snapping 
you want and the algorithm continues in that manner until you change your selection.

Snapping Examples
To hopefully give you a better explanation of the different types of snapping, we present the following 
examples.    For all of the examples, shape A is the active shape that has just been moved, flipped or 
rotated and is about to be snapped by the algorithm to shape B.

Point to Point - Example #1
Notice how the corners, or points, of triangle A have been snapped to the corners of triangle B.



Before the Snap After the Snap

Point to Point - Example #2
Notice how the corners, or points, of square A have been snapped to puzzle outline B.

Before the Snap After the Snap

Point to Line Example
Notice how the point forming the right angle in triangle A has been snapped to the left-mose edge, or line 
segment, of square B.    We say the "point has been snapped to the line".

Before the Snap After the Snap

Line to Point Example
Notice how the bottom-most edge, or line segment, of square A has been snapped to the point forming 
the right angle in triangle B.    We say the "line has been snapped to the point".



Before the Snap After the Snap



The Menu Commands
The following menus are available while playing OOG.

The Puzzle Menu              Selecting puzzles, save/restore progress, create/load a puzzle...
The Options Menu             Configure general & game options, change colors, change players...
The Switch Menu              Switch to the polyform puzzle of your choice
The Help Menu                  Complete access to the application help system

Following this link to see the menu commands available while creating your own puzzles.



The Puzzle Menu
The following commands are available from the Puzzle menu.

Next                                                 Advance to the next puzzle in the sequence
By Number...                     Choose a puzzle based on its assigned number
By Picture...                       Select a puzzle from a grid of picture buttons
Restart Puzzle                   Reset the game pieces to their starting locations
Save Layout...                   Save the current layout of your game pieces
Restore Layout...               Restore a previously saved layout of your game pieces
Create Puzzle...                 Create your own puzzle and save it to disk
Load Puzzle...                   Load a previously created puzzle from disk
Exit                                                  Leave the application



Advancing to the next puzzle
Selection of this menu item advances you to the next puzzle in the current polyform.    If you are currently 
at the last puzzle in the sequence, you will be wrapped back to the first puzzle.    This menu item is also 
available via the 'F2' function key during game play.

The following are the two other puzzle selection methods available in OOG.

Selecting a puzzle by it's number
Selecting a puzzle by it's picture



Selecting a puzzle by it's number
Selection of this menu item allows you to choose a puzzle based solely on its assigned puzzle number.    
Each puzzle in OOG is assigned a unique number for its assigned polyform.    The puzzle numbering 
system starts with number #1 and increases up to the maximum number of puzzles for that polyform.    
The By Number Dialog Box allows you to select a puzzle via its assigned number.    The following 
paragraphs describe the components of the dialog box.

Puzzle # Text
This text string is located directly above the scroll bar and identifies the current puzzle number selected 
by the scroll bar as well as whether or not that puzzle has been solved.    OOG determines whether or not 
the puzzle has been solved by accessing the player progress database that is being maintained by the 
player progress tracking feature.

Puzzle # Scroll Bar
The scroll bar is used to select which puzzle number is to be loaded.    The text string above the scroll bar 
identifies the current scroll bar position and the "solved status" of that puzzle.

Command Buttons
Click the OK button to have OOG load the puzzle corresponding to the number indicated by the scroll bar 
position and associated text.    Click the Cancel button if you wish to void your selection and return to the 
original puzzle you were playing.    Clicking the Help button will display this help page.

The following are the two other puzzle selection methods available in OOG.

Advancing to the next puzzle
Selecting a puzzle by it's picture



Selecting a puzzle by it's picture
Selection of this menu item allows you to choose a puzzle from an array of pictures via the By Picture 
Dialog Box.    The following sections describe the components of this dialog box.

Button Grid
The majority of the display area of this dialog box is composed of a grid of puzzle buttons.    The grid 
contains 3 rows of 4 buttons each for a total of 12 puzzle buttons.    Each button displays a picture of a 
different polyform puzzle with the assigned number for that puzzle displayed in the top, left corner of the 
button.    You select the puzzle of your choice, by clicking the appropriate button.    Any puzzle that has not
yet been solved by the current player has a capital 'U' displayed in the top, right corner of the puzzle 
button.    If the puzzle has been solved by the player, nothing additional is added to the button.    This 
allows you to easily determine which puzzles you haven't solved yet.    Quickly glance at the grid of 
buttons and look for the capital 'U's.    The solve status of the puzzles is stored in the player progress 
database which is maintained by OOG's player progess tracking feature.

Command Buttons
The Next and Prev buttons are used to sequence through the pages of puzzle buttons for the current 
polyform.    These buttons allow you to wrap around the sequence at either end.    For example if puzzle 
#1 is currently being displayed as the top, left button in the grid and you select the Prev button, the dialog 
box will sequence to the last page of buttons for the current polyform.
Click the Cancel button if you wish to exit the dialog box and return to your previous puzzle.    The Help 
button will display this help page.

The following are the two other puzzle selection methods available in OOG.

Advancing to the next puzzle
Selecting a puzzle by it's number



Restarting a puzzle from scratch
Selection of this menu item allows you to restart the current puzzle by resetting all the game pieces back 
to their original positions. This menu item is also available via the 'F3' function key.



Saving your progress on a puzzle
This feature allows you to save the current layout of your game pieces to disk.    The layout can then be 
restored at a later time so you can pick up right where you left off on a puzzle.    The save layout feature is
available from the menu system both when you are solving and when you are creating polyform puzzles 
with OOG.    If you are an unregistered user evaluating the shareware version of OOG, this feature will 
become disabled after your evaluation period has ended.

Upon selection of this menu item you will be presented with the Save Layout Dialog Box.    This is just a 
standard File Save Dialog Box.    The dialog box's File Name edit control will contain one of the following 
suggested file names:

1) XXX_###.SAV when solving puzzles
2) XXX_PUZ.SAV when creating puzzles

The .SAV file extension indicates you are saving a puzzle layout.    The ### will contain the puzzle 
number for the current puzzle you are solving and will always contain three digits.    If the puzzle number 
requires less than three digits it will have leading zeroes.    The XXX characters are references to which 
polyform puzzle you are currently working with as shown below.    If you are solving a puzzle that you 
have loaded from disk, the suggested file name will be the name of the loaded puzzle file with the .SAV 
file extension.

Polyform File Name Characters
Tangrams TAN
Pentominoes PNT
Hexagons HEX
Polyominoes PLY

Command Buttons
Once you've selected the desired destination directory and file name for storing the saved layout, click the
OK button to write the puzzle layout data to disk.    Click the Cancel button if you decide you no longer 
wish to save your current layout.    Clicking the Help button will display this help page.

Follow this link for information about how to restore your puzzle layouts.



Restoring your progess on a puzzle
This feature allows you to restore a previously saved layout of your game pieces from disk.    The restore 
layout feature is available from the menu system both when you are solving and when you are creating 
polyform puzzles with OOG.

Upon selection of this menu item you will be presented with the Restore Layout Dialog Box.    This dialog 
box is just a slightly modified version of the standard File Open Dialog Box.    The addition to this dialog 
box, a File Preview Window, is discussed below.

File Name Edit Control Contents
When displayed, the dialog box's File Name edit control will contain one of the following suggested file 
names:

1) XXX_###.SAV when solving puzles
2) XXX_*.SAV when creating puzles

The .SAV file extension indicates you are restoring a previously saved puzzle layout.    The ### will 
contain the puzzle number for the current puzzle you are solving and will always contain three digits.    If 
the puzzle number requires less than three digits it will have leading zeroes.    The XXX characters are 
references to which polyform puzzle you are currently working with as shown below.    If you are solving a 
puzzle that you have loaded from disk, the suggested file name will be the name of the loaded puzzle file 
with the .SAV file extension.

Polyform File Name Characters
Tangrams TAN
Pentominoes PNT
Hexagons HEX
Polyominoes PLY

File Preview Window
Whenever you select a file from the File Name list box control, which is directly under the File Name edit 
control, a picture of the layout contained within the file gets displayed in the File Preview window.    This 
window is located below the OK & Cancel buttons found in the top right corner of the dialog box.    The 
contents of the file are only displayed if the file is recognized as being an OOG layout file that 
corresponds to the current polyform you are playing (see Potential Pitfalls discussed below).

Command Buttons
Once you've selected the desired source directory and file name for the layout you wish to restore, click 
the OK button.    Click the Cancel button if you decide you no longer wish to restore a layout from disk.    
Clicking the Help button will display this help page.

Potential Pitfalls
This operation will reject any file it does not recognize as being an OOG layout file.    If you attempt to load
"any old file" using this command, it will be rejected.    You can not load a created puzzle file using this 
operation.    The file will be rejected.    You can only load layout files saved for the current polyform puzzle. 
For instance if you try to restore a Pentominoes layout while playing Tangrams, if will be rejected.    First 
switch to Pentominoes and then restore the layout using this operation.    You have been warned.

Follow this link for information about how to save your puzzle layouts.



Creating your own puzzles
Selection of this menu item allows you to create your own puzzles.    Upon selection you will be presented
with a message box asking whether or not you want the game pieces reset to their default positions prior 
to entering the create a puzzle environment.    Click the Yes button if you would like the pieces reset to 
their default positions and orientations.    However, if during the solving of a puzzle you've come up with 
an arrangement that you would like to make into your own puzzle, click the No button to keep the current 
layout intact.    If you no longer wish to start creating puzzles, then you should click the Cancel button.

Note that in the shareware version of OOG created puzzles can not be saved to disk.    Shareware users 
will be able to fully evaluate the operation of creating a puzzle.    However when it comes time to actually 
save the created puzzle to disk, shareware users will be notified that this operation is only available to 
registered users.    To be able to save created puzzles to disk, you must register your copy of OOG.



Loading a puzzle from disk
This feature allows you to load, from disk, a puzzle you or someone else previously created with OOG.    
Follow this link to learn how to create your own puzzles.    Upon selection of this menu item you will be 
presented with the Load Puzzle Dialog Box.    This dialog box is just a slightly modified version of the 
standard File Open Dialog Box.    The addition to this dialog box, a File Preview Window, is discussed 
below.    The dialog box's File Name list box area will default to showing all files with the following file 
extensions depending on which polyform puzzle you are currently playing.

Polyform File Extension
Tangrams .TAN
Pentominoes .PNT
Hexagons .HEX
Polyominoes .PLY

File Preview Window
Whenever you select a file from the File Name list box control, which is directly under the File Name edit 
control, a picture of the layout contained within the file gets displayed in the File Preview window.    This 
window is located below the OK & Cancel buttons found in the top right corner of the dialog box.    The 
contents of the file are only displayed if the file is recognized as being an OOG layout file that 
corresponds to the current polyform you are playing (see Potential Pitfalls discussed below).

Command Buttons
Once you've selected the desired source directory and file name for the puzzle you wish to load, click the 
OK button to load that puzzle into OOG.    Click the Cancel button if you decide you no longer wish to 
load a puzzle from disk.    Clicking the Help button will display this help page.

Puzzle Load Times
Whenever OOG loads a user created puzzle from disk, an algorithm is invoked to find the outer edges 
that form the puzzle outline.    (The outline is what gets displayed over the background when you are 
solving the puzzle.)    This algorithm is very complex and depending on the complexity of the puzzle and 
the type of machine OOG is running on can be quite time consuming.    If OOG detects that the algorithm 
is taking a long time to finish (greater than 1 or 2 seconds), it pops up a status dialog box informing you 
that the algorithm is still running.    This dialog box is a simple heartbeat monitor intended to let you know 
that the program has not crashed or gotten stuck.

Potential Pitfalls
This operation will reject any file it does not recognize as being an OOG puzzle file.    If you attempt to 
load "any old file" using this command, it will be rejected.    You can not load saved layout files using this 
operation.    These files will be rejected.    You can only load puzzle files created for the current polyform 
puzzle.    For instance if you try to load a Pentominoes puzzle while playing Tangrams, if will be rejected.    
First switch to Pentominoes and then load the puzzle using this operation.

Note that in the shareware version of OOG you can not load created puzzles from disk.    To be able to 
load created puzzles from disk, you must register your copy of OOG.



Exiting OOG
Selection of this menu item exits OOG and returns you to the Windows operating system.



The Options Menu
The following commands are available from the Options menu.

General Setup... Adjust general setup options
Game Setup...                   Adjust setup options specific to each polyform game
New Player...                     Change players
Puzzle Stats... Change puzzle statistics (solved or unsolved)
Set Shape Color... Select the color of the game pieces
Set Puzzle Color... Select the color of the puzzle outline
Give Hint                           Cheat a little (you get to choose the piece)
Show Solution                   I give up, cheat big time



Setting up general options
Selection of this menu item allows you to configure some of the general operations performed by OOG.    
After selecting this item, you will be presented with the General Setup Dialog Box.    The interface 
components of this dialog box are discussed below.

Animation - Hints, Solution
Check this box if you would like OOG to animate the movement and rotation of the shapes whenever you 
ask for a hint or the solution to the current polyform puzzle.    If this box is unchecked, OOG simply places 
the shapes at their intended location when giving a hint or showing the solution to a puzzle.

Animation - Game Over Fanfare
Check this box if you would like OOG to perform its "game over" fanfare whenever you solve a puzzle.    If
this box is unchecked, you do not get any of the "game over" fanfare.    The fanfare consists of some 
simple graphics drawing and the playing of the "game over" WAV sound file.    The playing of the WAV 
sound file is also dependent upon the setting of the Enable All Sounds check box discusssed next.    As a 
result, it is possible to have the confetti thrown on the screen without having to listen to the WAV sound 
file.    (This is for those of you playing at work.)

Sound - Enable All Sounds
Check this box to enable the playing of all sounds within OOG.    If this box is unchecked, no sounds will 
be played.    Currently, the "game over" WAV file is the only available sound played by OOG.    (See the 
above discussion of the "game over" fanfare.)

Command Buttons
Select the OK button to accept your current settings in the dialog box.    If after entering this dialog box 
you change your mind and don't wish to make any changes or would like to restore your original settings, 
select the Cancel button.    Selection of the Help button displays this help page.



Setting up game options
Selection of this menu item allows you to configure options specific to each of the polyform puzzle games 
included with OOG.    After selecting this item, you will be presented with the Game Setup Dialog Box.    
The settings made in this dialog box affect only the puzzles for the game you are currently playing.    For 
instance if you are playing Pentominoes, the changes you make in this dialog box only affect the 
Pentominoes puzzles.    If you want to make similar changes for one of the other puzzle games, you will 
have to switch to that game and make the changes again.    The interface components of this dialog box 
are discussed below.

Rotation Interface - Drag Using Right Mouse Button
This is the default operation for rotating game pieces.    When this option is selected, game pieces are 
rotated using a simple "click and drag" operation.    For more detailed information about rotating shapes, 
read the section on how to play OOG.

Rotation Interface - Single Click of Right Mouse Button
Selecting this option allows you to rotate the pieces using just a single click of the right mouse button.    
Simply click the right button to rotate the shape in the clockwise diretion.    Hold down the CTRL key and 
click to rotate in the counter-clockwise direction.    For more detailed information about rotating shapes, 
read the section on how to play OOG.

Rotation Angle
The selection made in this group of options determines how much distance a shape moves during a 
rotate operation.    For those of you unfamiliar with the concept of angles and degrees and how they relate
to rotation, we'll try to explain it.    Picture a circle and divide it up into pieces as if you were slicing a pie.    
The amount of space taken up by each piece represents a certain angular chunk of the circle.    The size 
of each angular chunk is equal to a certain number of degrees where the total number of degrees in the 
full circle is always 360.    For example if you divide a circle into 4 equal pieces, each piece represents an 
angle of 90 degrees.    Divide a circle into 24 equal pieces and each piece represents an angle of 15 
degrees.

When you rotate a game piece using the mouse, the shape rotates around one of it's points as described 
in the section on how to play OOG.    Think of this point of rotation as the center of a circle.    The amount 
of degrees the shape moves around this circle is equal to the selection you make in this group of options. 
If you're interested in exploring, play around with different selections in this dialog box and then do some 
shape rotations to see the affect they have.

Note of Caution: If you are trying to solve a puzzle and find you are having trouble getting a shape to 
rotate into the desired position, check your current rotation angle selection.    It is possible that with your 
current selection you will be unable to get the shape to the position you want.    To overcome this problem,
simply set the rotation angle to 15 degrees.    Since this is the smallest allowable value for the rotation 
angle, any shape rotational position can be achieved using this setting.

Setting - Snap Game Pieces to Puzzle Outline
By default, the OOG snapping algorithm is configured to automatically guess at the intended location of a 
game piece after it has been moved, rotated or flipped and then snap the game piece to the guessed at 
location thereby freeing the player from having to worry about perfectly aligning the game pieces along 
side each other and/or the puzzle outline.    When this box is checked, the snapping algorithm works as 
just described.    If you uncheck this box, snapping only occurs between game pieces.    No snapping will 
be done to the puzzle outline.    Remember, it is not necessary to solve the puzzle by perfectly aligning the
game pieces with the puzzle outline.

Command Buttons
Select the OK button to accept your current settings in the dialog box.    If after entering this dialog box 



you change your mind and don't wish to make any changes or would like to restore your original settings, 
select the Cancel button.    Selection of the Help button displays this help page.



How to change players
Selection of this menu item brings up the New Player dialog box. The selections made in this dialog box 
control which player progress database the player progress tracking feature will be maintaining.

Enter/Select Your Name Combo Box
This combo-box is used to restore/create a player progess database that will be maintained by OOG 
during subsequent gaming sessions.    If this is your first time playing and you would like to have your 
player progress database stored on disk for future sessions, enter your name into this control.    If you've 
played OOG before and already have a player progress database setup, find your name in the list box 
and select it.    OOG will then load your database from disk.

Visitor's Check Box
If this box is checked, the current player is identified as a visitor and the player progress database will 
only be maintained during the current gaming session.    Once the player quits OOG or switches to 
another polyform, the information currently stored in the database will be lost.

Restore Last Player at Startup
The New Player Dialog Box is automatically opened by OOG whenever the application is started.    This 
gives the user an opportunity to ensure that the correct player progress database is loaded.    If you check
this box, OOG will automatically restore the information for the last player without having to display this 
dialog box at startup.    If you would like to have the dialog box displayed whenever the applicatioin is 
started, make sure this box is unchecked.

Delete Button
Selection of this button allows you to delete the player currently selected in the Enter/Select Your Name 
Combo Box.    When a player is deleted, their name is removed from the internal OOG player list.    At the 
same time, the player's progress tracking database for each polyform puzzle they have played is also 
deleted.    Once deleted, there is no way to recover this data.    For this reason, this command should be 
used with caution.    After selecting a player from the list and pressing this button, you will be asked to 
confirm your decision.    Simply choose OK to delete the selected player or Cancel if you've changed your
mind.    Note that you will not be allowed to delete the player currently logged in as the active player.    To 
delete the currently active player, simply use this dialog box to switch to another player or the visitor and 
then return to the dialog box to delete the player.    If you try to delete the currently active player, you will 
be presented with a message box asking you to switch to another player and then try again.

Invalid New Player Message Box
If the Visitor's Check Box is unchecked and the Enter/Select Your Name Combo Box is empty and you 
then select the OK button, you will be presented with a message box informing you that you have not 
identified a player.    Click the OK button on the message box and make another selection in the dialog 
box.



Changing puzzle statistics
Selection of this menu item brings up the Player's Puzzle Statistics dialog box.    The controls in this dialog
box allow you to see and manipulate the contents of your player progress tracking database for the 
current polyform.    From this dialog box you can change the status of any or all of your puzzles from 
solved to unsolved or vice versa.    You can also see how many puzzles you have solved so far and 
determine how many more you still have to go.

Individual Puzzles
This section of the dialog box contains three primary controls.    The Puzzle Selection scroll bar and the 
Mark and Clear buttons.    Slide the scroll bar to the puzzle number of interest.    The line of text above the 
scroll bar changes to identify the puzzle by its assigned number and also displays the solve status of the 
puzzle.    The Mark button can be used to mark that particular puzzle as solved while the Clear button is 
used to clear the puzzle to unsolved.

All Puzzles
This section of the dialog box contains two primary controls.    The Mark All and the Clear All buttons.    
The line of text above the two buttons identifies how many puzzles you have solved so far.    By 
subtracting the first number in the text from the second number, you can determine how many puzzles 
you still have to solve before you've solved them all.    The two buttons can be used to mark all the 
puzzles as solved or to clear all the puzzles to unsolved.

When You're Done
After you are done making your desired selections in this dialog box, choose OK to save your changes or 
Cancel to throw them away and keep the original settings intact.    Clicking the Help button, will display 
this help page.



Changing the color of the game pieces
Selection of this menu item allows you to change the color of the game pieces, or shapes, of the current 
polyform puzzle.    You can select different color settings for each polyform found in OOG and they will be 
remembered for the next time you play.

After selecting this item, you will be presented with the Choose Color Common Dialog Box.    This is a 
standard, built-in Windows dialog box.    Select the rectangle displaying the color of your choice and click 
the OK button.    OOG will automatically update the associated screen object(s) with that color and 
memorize the selection for next time.    Remember, OOG memorizes the colors for each polyform 
separately.    So you can have different color selections for each polyform!

If you change your mind and don't wish to make a new color selection, just click the Cancel button and 
the original colors will be unaffected.

Selection of the Help button, displays this help page.



Changing the color of the puzzle
Selection of this menu item allows you to change the color of the puzzle outlines of the current polyform 
puzzle.    You can select different color settings for each polyform found in OOG and they will be 
remembered for the next time you play.

After selecting this item, you will be presented with the Choose Color Common Dialog Box.    This is a 
standard, built-in Windows dialog box.    Select the rectangle displaying the color of your choice and click 
the OK button.    OOG will automatically update the associated screen object(s) with that color and 
memorize the selection for next time.    Remember, OOG memorizes the colors for each polyform 
separately.    So you can have different color selections for each polyform!

If you change your mind and don't wish to make a new color selection, just click the Cancel button and 
the original colors will be unaffected.

Selection of the Help button, displays this help page.



Asking for a hint to a puzzle
Selection of this menu item allows you to receive a hint for the game piece of your choice.

You will be presented with a message box informing you to select the game piece for which you desire a 
hint.    If you decide you no longer want a hint, click the Cancel button.    Otherwise, click the OK button 
and then place the mouse cursor over the piece for which you want the hint and click the left mouse 
button.    (You can cancel your request for a hint, even after you select the OK button by pressing the Esc 
key.)    OOG will then position the shape you selected to the desired location either directly or using 
animation according to the settings in the Game Setup dialog box.

It should be noted that many polyform puzzles have more than one solution and even though OOG will 
detect your solution regardless of which one you find, all of the hints are based on a single solution built 
into OOG.    In other words, just because the hint mechanism places shape 'X' at location 'Y' that doesn't 
mean the puzzle can't be solved with shape 'X' in a totally different location.

If by some odd coincidence the intended position/orientation of the hint is identical to the current 
position/orientation of the selected game piece, a message box is displayed informing you of this 
condition.    (This is so you don't wonder why the selected piece was not moved anywhere.)

Follow this link for more information about solving polyform puzzles.



Asking for the solution to a puzzle
Selection of this menu item allows you to "give up" and see the solution for the current polyform puzzle.    
To guard against an accidental selection of this menu item, you will be presented with a message box 
verifying that you really want to see the solution.    If you don't wish to see the solution to the puzzle, click 
the No button.    Otherwise click the Yes button.

OOG will then proceed to position each shape in the polyform to its solution location either directly or 
using animation according to the settings in the Game Setup dialog box.

It should be noted that many polyform puzzles have more than one solution and even though OOG will 
detect your solution regardless of which one you find, it will always show the same solution for a given 
polyform puzzle when using this option because only one solution has been "built in" to satisfy this feature
and to give out hints (see below).

Follow this link if you just need a little hint.

Follow this link for more information about solving polyform puzzles.



The Switch Menu
The following commands are available from the Switch menu.

Tangrams                          Switch to the Tangrams polyform
Pentominoes                     Switch to the Pentominoes polyform
Hexagons                          Switch to the Hexagons polyform
Polyominoes Switch to the Polyominoes polyform



Switching to Tangrams
Selection of this menu item lets you play puzzles from the Tangrams polyform.



Switching to Pentominoes
Selection of this menu item lets you play puzzles from the Pentominoes polyform.



Switching to Hexagons
Selection of this menu item lets you play puzzles from the Hexagons polyform.



Switching to Polyominoes
Selection of this menu item lets you play puzzles from the Polyominoes polyform.

Note that this polyform puzzle is only available to registered users of OOG.



The Help Menu
The following commands are available from the Help menu.

Index                                               Displays the Index of this help file
Commands                        Displays the Commands section of this help file
How to Play                       Displays the How to Play section of this help file
Using Help                         Displays information about how to use help
What is Shareware...         Simple description of the concept of shareware
Why Register...                  Describe reasons and incentives for registering
How to Register...              Instructions for how to register
Register OOG... Registration dialog box
About...                                            Standard About Box



Displaying the help index
Selection of this menu item displays the table of contents for the OOG Help System.



Displaying help on the menu commands
Selection of this menu item displays a help page that provides access to descriptions of all the menu 
commands available while playing OOG.



Displaying help on how to play OOG
Selection of this menu item displays a help page describing how to play OOG.



Displaying help on using the help system
Selection of this menu item displays the standard Microsoft help file describing how to use the Microsoft 
Windows WinHelp application. This is how you can get help on help.



Learning about the concept of shareware
Selection of this menu item displays a help page describing the concept of shareware.



Learning about why you should register
Selection of this menu item displays a help page describing the benefits you receive by registering OOG 
with MCM Productions.



Learning about how to register
Selection of this menu item displays a help page describing how to register OOG with MCM Productions.



Upgrading OOG from Shareware to Registered
Selection of this menu item allows you to upgrade your copy of OOG from the shareware version to the 
registered version.    As part of this process, you will be required to specify the user name and serial 
number sent to you by MCM Productions after we've processed your registration.    After selecting this 
item, you will be presented with the OOG Registration Dialog Box.    The interface components of this 
dialog box are discussed below.

User Name
Enter the user name you received in response to your registration.

Serial Number
Enter the serial number you received in response to your registration.

Command Buttons
Once you are satisfied the user name and serial number you have entered are correct, click the Register 
button.    After the information has been validated, you will be presented with a message box 
congratulating you on the successful registration of OOG.    (Your user name will now be displayed in the 
"Registered to:" section of the OOG About Box.)    If the entered data can not be successfully validated, 
you will be asked to recheck the data and try entering it again.    Click the Cancel button if you wish to 
leave this dialog box without entering your registration data.

How do I Register OOG ?

What are the Benefits of Registering OOG ?



Displaying the OOG About Box
Selection of this menu item displays the OOG About Box.    An About Box is used to provide company and
program version information to the user.    The "Registered to:" window of the About Box will change from 
"UnRegistered" to your user name after you have registered your copy of OOG and entered your 
registration information in the OOG Registration Dialog Box.    If you are evaluating the shareware version 
of OOG, a line of text on the bottom of the About Box will display how much time is remaining in your 
evaluation period.    Read about the concept of shareware to learn more about our shareware evaluation 
period.

How do I register OOG ?
About MCM Productions



How to create your own puzzles
So you want to know how to create your own polyform puzzles.    Well, you've come to the right page.    
Using this feature you can create a seemingly endless number of puzzles that you can then exchange 
with others by simply giving them a copy of your puzzle files.    (Don't forget to ask for a copy of their 
puzzle files in return.)    The format of these puzzles files is identical to the puzzle data stored inside of 
OOG.    The only difference is that they are loaded from disk.    This means that anything you can do with a
built-in puzzle, you can do with a user created puzzle!    For example, after loading a user created puzzle 
from disk you can still:

· ask for a hint if the puzzle is really giving you a hard time
· ask for the solution if you've totally given up
· save your layout so you can try again later

Some Fine Print
So as not to appear to mislead anyone, we must inform you that the operation of this feature differs 
between the shareware and registered versions of OOG.    The shareware version of OOG allows you to 
go through the motions of creating your own puzzles so you can evaluate how it works.    However when it
comes time to actually store the created puzzle to disk, the shareware version will not let you perform this 
step.    The shareware version will also not let you load puzzles created by other registered users.    To 
have access to these two features, you must register your copy of OOG.

How can I access this great feature!?
Simply select the Create Puzzle... item from the Puzzle Menu.

Now what do I do?
You design your puzzle by moving, rotating and flipping the given set of shapes that are available for the 
current polyform.    You do this using the exact same shape maneuver operations you use when trying to 
solve puzzles.    Create your puzzles anywhere on the window you desire.    OOG automatically centers 
your puzzle within the window prior to saving it to disk.    Once you're happy with your puzzle design, you 
can save it to disk and give a copy of the puzzle file to a friend so they can load it from disk and give it a 
try.

Exchanging Puzzles via the Internet
We have configured our FTP site to allow registered users of OOG to exchange the puzzles they have 
created.    You can FTP to our site as an anonymous user and upload your puzzle files into the 
appropriate directory for incoming puzzles.    From our FTP site you can also download the puzzle files 
which have been uploaded by others.    See the README files available on our FTP site for more 
information about where to upload and download puzzle files.

Things to Remember
1) Polyform puzzles are not allowed to contain any overlapping shapes.    OOG verifies your puzzle meets
this condition before it allows the puzzle to be saved to disk.    This means that the edges and corners of a
shape are allowed to "touch" the edges or corner of another shape, but they are not allowed to cross into 
or over those of another shape.    You can use the save and restore layout commands if you wish to save 
the arrangement of your game pieces to disk before they are ready to be saved as a puzzle.

2) Each puzzle you create will always contain all the shapes in the current polyform.    For example, 
suppose you're creating a puzzle for the Pentominoes polyform and the resultant design uses only 10 of 
the 12 shapes.    The other 2 shapes must be a part of the puzzle.    We suggest you take the 2 unused 
shapes and artistically place them about your puzzle design as "free floating freebies" for the puzzle 
solver.

Create Menu Commands



What menu commands are available while creating a puzzle?    Follow the link.



The Create Menu Commands
The following menus are available when you are creating a puzzle.

The Create Menu Save/restore your progress, save your puzzle creation...
The Help Menu                  Complete access to the application help system

The majority of the items available on the Create Menu are also available through the use of the OOG 
Quick-Click Menu.    This menu is simply a popup, shortcut menu that is displayed whenever you click and
hold down the right mouse button over the main window background when you are creating a puzzle.    
This shortcut menu also contains items that allow you to configure the way in which the game pieces 
snap together after a shape maneuver operation.

Following this link to see the menu commands available while playing OOG.



The Create Menu
The following commands are available from the Create menu while creating a puzzle.

Reset Shapes Reset the game pieces back to their default positions
Save Layout... Save the current layout of your game pieces
Restore Layout... Restore a previously saved layout of your game pieces
Save Puzzle... Validate and save your created puzzle to disk
Cancel Create Stop creating without saving your work



Resetting the game pieces
Selection of this menu item resets each of the game pieces back to their default position.    This menu 
item is also available via the 'F3' function key.



Saving the puzzles you create
Selection of this menu item allows you to save the puzzle you've created to disk.    Each puzzle that you 
create and save to disk is stored in a separate file with the name of your choosing.    These files can be 
exchanged with other users of OOG and then loaded into the program for even more game play.    After 
you select this menu item, the following steps are performed in the order listed.

Step 1 - Puzzle Validation
OOG verifies the validity of your puzzle by ensuring that none of the game pieces overlap.    Remember, 
this is a general rule for all polyform puzzles.    If overlapping pieces are detected, you will be presented 
with a message box asking that you remove the overlap and try saving again.    If OOG is able to 
successfully validate your puzzle, you move on to the next step.    You can use the save and restore 
layout commands if you wish to save the arrangement of your game pieces to disk before they are ready 
to be saved as a puzzle.

Step 2 - Name Your Puzzle
This step gives you the ability to customize your puzzle by giving it a name or description.    Note that this 
is not the name of the file used to store your created puzzle to disk.    This name will appear in the text 
window directly above the main play area on the OOG window.    You can name the puzzle anything you 
like.    We suggest something that you think describes what the puzzle looks or maybe you could use your
own name followed by a number you assign to the puzzle.    (You're going to create more than one puzzle 
aren't you?)    In the displayed dialog box, simply type the name or description you've decided on for the 
puzzle and click the OK button to proceed to the next step.    If you click the Cancel button in this dialog 
box, you will abort the entire save process and your puzzle will not be saved to disk.

Step 3 - Save Your Puzzle to Disk
Finally, you will be presented with the Save Puzzle Dialog Box.    This is just a standard File Save Dialog 
Box.    The dialog box's File Name edit control will contain the following suggested file name: 
"PUZZLE.XXX".

The file extension, shown as XXX above, will vary depending on which type of polyform puzzle you are 
currently creating.    The table below details the possible values for the file extension.    We suggest you 
change the file name to something a little more descriptive.

Polyform File Extension
Tangrams .TAN
Pentominoes .PNT
Hexagons .HEX
Polyominoes .PLY

Once you've selected the desired destination directory and file name for saving your puzzle, click the OK 
button to write the data to disk. Click the Cancel button if you decide you no longer wish to save your 
puzzle.    Clicking the Help button will display this help page.

That's It!
Your puzzle is now stored on disk and can be played by loading it into OOG.    At this point, OOG will ask 
if you wish to create another puzzle.    Answer appropriately and you're on your way.

Some Fine Print
So as not to appear to mislead anyone, we must inform you that the operation of this feature differs 
between the shareware and registered versions of OOG.    The shareware version of OOG allows you to 
go through the motions of creating your own puzzles so you can evaluate how it works.    However when it
comes time to actually store the created puzzle to disk (step 3 shown above), the shareware version will 
not let you perform this step.    The shareware version will also not let you load puzzles created by other 



registered users.    To have access to these two features, you must register your copy of OOG.



When you want to stop creating puzzles
Selection of this menu item allows you to stop creating a puzzle without having to save your work.    Upon 
selection, you will be presented with a message box to verify your desire to stop creating puzzles.    Click 
the Yes button if you wish to stop creating and don't want to save your work.    If you've changed your 
mind and want to continue creating a puzzle, click the No button.



The Create Help Menu
The following commands are available from the Help menu while creating a puzzle.

Index                                               Displays the Index of this help file
Commands                        Displays the Create Commands section of this help file
How to Create                   Displays the How to Create section of this help file
Using Help                         Displays information about how to use help
About...                                            Standard About Box



Displaying the help index
Selection of this menu item displays the table of contents for the OOG Help System.



Displaying help on how to create a puzzle
Selection of this menu item displays a help page describing how to create your own puzzles.



Displaying help for the create menu commands
Selection of this menu item displays a help page that provides access to descriptions of all the menu 
commands available while creating a puzzle with OOG.



Displaying help on using the help system
Selection of this menu item displays the standard Microsoft help file describing how to use the Microsoft 
Windows WinHelp application. This is how you can get help on help.



Displaying the OOG About Box
Selection of this menu item displays the OOG About Box.    An About Box is used to provide company and
program version information to the user.    The "Registered to:" window of the About Box will change from 
"UnRegistered" to your user name after you have registered your copy of OOG and entered your 
registration information in the OOG Registration Dialog Box.    If you are evaluating the shareware version 
of OOG, a line of text on the bottom of the About Box will display how much time is remaining in your 
evaluation period.    Read about the concept of shareware to learn more about our shareware evaluation 
period.

How do I register OOG ?
About MCM Productions



The Shareware Concept
What is Shareware?
When most people hear the word shareware they usually associate it with a particular software 
application.    However the term shareware is not describing the program itself but the manner in which 
the program is being distributed.    Shareware is a distribution concept that allows you, the potential buyer,
to evaluate a piece of software before you are required to pay for it.    A shareware author, the seller, trusts
you to pay for, or register, the program if you continue to use it beyond the stipulated evaluation period.    
The shareware system makes finding software that suits your needs and pocketbook easier, because you
can try before you buy.    And because the overhead is low, prices are low also.    Shareware has the 
ultimate money-back guarantee:    If you don't use the product, you don't pay for it.

Our Terms & Conditions
OOG is a complete, full-featured application being distributed as shareware.    Using the shareware 
version of the program, you will be able to fully evaluate each feature available in OOG.    Our evaluation 
period allows you to use the shareware version for 30 days AND to run the program 30 times.    This is an 
important point and a little bit different than what most shareware authors offer so read the next few 
sentences carefully.    After installation, the evaluation period does not expire until after both 30 days have 
elapsed AND you have run the program 30 times.    This means that if after the first time you run OOG you
don't look at it again for 30 or more days, when you do finally come back to use it you will still have 29 
more chances to run it before the evaluation period expires.    To look at it from the other side of the coin, 
if you run OOG 30 different times on the first day you install it you will still have 29 more days to evaluate 
it before the evaluation period expires.    If you continue to use OOG beyond the evaluation period, you 
must register and pay for your copy.

More Useful Information
What are the Benefits you Receive after Registering OOG ?
How do you Register OOG ?
Association of Shareware Professionals (ASP)

License Agreement
Warranty Disclaimer



The Benefits of Registering
The Evaluation Period
OOG is a complete, full-featured application being distributed as shareware.    Using the shareware 
version of the program, you will be able to fully evaluate each feature available in OOG.    Our evaluation 
period allows you to use the shareware version for 30 days AND to run the program 30 times.    This is an 
important point and a little bit different than what most shareware authors offer so read the next few 
sentences carefully.    After installation, the evaluation period does not expire until after both 30 days have 
elapsed AND you have run the program 30 times.    This means that if after the first time you run OOG you
don't look at it again for 30 or more days, when you do finally come back to use it you will still have 29 
more chances to run it before the evaluation period expires.    To look at it from the other side of the coin, 
if you run OOG 30 different times on the first day you install it you will still have 29 more days to evaluate 
it before the evaluation period expires.    If you continue to use OOG beyond the evaluation period, you 
must register and pay for your copy.

Why Should I Register
The purpose of this page is to discuss the differences between the shareware and registered versions of 
OOG.    Our intent is to highlight the benefits you will receive after registering.    Follow the link to learn 
how to register OOG.

OOG is actually several games in one.    Each game allows you to play a different polyform puzzle.    Each
polyform puzzle uses exactly the same interface and has exactly the same set of features as the others.    
Once you know how to play one polyform puzzle, you know how to play all of them.    Any function you 
can do with one polyform puzzle, you can do with all of them.    In the shareware evaluation version we 
give you a sampling of the available puzzles.    The main incentive for registering is gaining access to 
many more puzzles.

Free Upgrades for Registered Users
Any future upgrades that are released to add new features or correct problems are available free of 
charge to all registered users.    Registered users will be notified of upgrades and new releases via e-mail 
or the postal service if no e-mail address was supplied during registration.    Upgrades will be available for 
download from the Internet, CompuServe and the MCM Productions Web site.    Those users who don't 
have access to the Internet or CompuServe can contact us to receive an installation disk.

Differences Between the Shareware & Registered Versions
The following list details the differences between the shareware and registered versions of OOG.    Please
don't be dismayed by the long list of differences.    This is an exhaustive list and most of the items below 
are minor details that don't take away from game play.

1) When running the shareware evaluation version, the title area will always display "OOG - 
UnRegistered".    After registration the word "UnRegistered" will be replaced the name of the current 
puzzle game you are playing, for example "Tangrams".

2) The splash screen image that gets displayed during startup is kept on screen for no more than 5 
seconds when running the shareware evaluation version.    The screen is displayed for no more than 2 
seconds for registered users.

3) The number of puzzles available in each polyform game is different between the shareware and 
registered versions.    Refer to the feature comparison table at the bottom of this page for complete 
details.

4) When running the shareware evaluation version, created puzzles can not be saved to disk.    
Shareware users will be able to fully evaluate the operation of creating a puzzle.    However when it 
comes time to actually save the created puzzles to disk, users will be notified that this operation is only 



available to registered users.

5) When running the shareware evaluation version, you will not be able to load and play puzzles created 
by other users of OOG.

6) The "Registered to:" section of the About Box displays the text "UnRegistered" when running the 
shareware evaluation version.    After registration this text is replaced by your assigned user name.

7) When running the shareware evaluation version, a line of text at the bottom of the About Box displays 
the current amount of time remaining in your evaluation period.    The terms of the evaluation period are 
discussed at the top this page.

8) The following items detail changes in the way OOG operates once the evaluation period has expired:

· You will no longer be able to save your progess on a puzzle.
· Upon closure, a "don't forget to register" nag screen will be displayed.

As you can see the list is exhaustive.    We wanted you to fully understand the differences between the 
two so you can appreciate the benefits you will be receiving after you register.    The idea behind the 
shareware version of OOG is to "whet your appetite" for more puzzles.    As shown in the table below, 
more puzzles is exactly what you get after registering.

============================================
The Shareware vs. Registered Feature Comparison Table
============================================
Polyform Game: Tangrams
# of Puzzles: 30 Shareware, 175 Registered
Load Puzzles from Disk: No Shareware, Yes Registered
Save Puzzles to Disk: No Shareware, Yes Registered
============================================
Polyform Game: Pentominoes
# of Puzzles: 1 Shareware, 75 Registered
Load Puzzles from Disk: No Shareware, Yes Registered
Save Puzzles to Disk: No Shareware, Yes Registered
============================================
Polyform Game: Hexagons
# of Puzzles: 1 Shareware, 50 Registered
Load Puzzles from Disk: No Shareware, Yes Registered
Save Puzzles to Disk: No Shareware, Yes Registered
============================================
Polyform Game: Polyominoes
# of Puzzles: N/A Shareware, 30 Registered
Load Puzzles from Disk: N/A Shareware, Yes Registered
Save Puzzles to Disk: N/A Shareware, Yes Registered
============================================



How to Register
You register your copy of OOG by paying MCM Productions the appropriate registration fee using one of 
the methods discussed below.    Upon receipt or notification of your registration, MCM Productions will 
send you your user name and serial number which when installed using the OOG Registration Dialog Box
will give you full access to the registered version of OOG.

The cost of OOG is $19.95 (US funds) per copy. All future releases of OOG, either to add or enhance 
features or to correct problems, are free after your one-time registration fee has been paid.    If you would 
like to install OOG on multiple computer systems at your site, please contact us for site license pricing 
information.    The more copies of OOG you purchase for your site, the better the price (perfect for 
educational institutions).

Registration Method #1 - Check or Money Orders
Fill out and send the registration form with a money order or a cheque drawn on a US bank to the address
listed on the form.    Users outside the United States please send an International Money Order or a 
cheque from any bank that has a corresponding bank in the US.    Your cheques should be made payable 
to "MCM Productions" in US funds only.    If you supply an e-mail address on the registration form, we will 
send you an e-mail message indicating that we have received and are processing your registration.    Your
user name and serial number will be mailed to you using the postal service within 24 hours of receiving 
your order.    Note that you assume all risk if you elect to send US cash through the mail.

Registration Method #2 - Electronic Registration via CompuServe
If you have a CompuServe account, you can use CompuServe's shareware registration service to register
your copy of OOG.    Just "GO SWREG" and follow the prompts.    The registration ID # for OOG is 11672. 
CompuServe will bill the $19.95 US registration fee to your account.    If you use this service, MCM 
Productions will send your user name and serial number to your CompuServe account via an e-mail 
message within 24 hours of receiving your order.

Registration Method #3 - Credit Card Orders
Credit card orders may be placed with the Public (software) Library by contacting them using one of the 
methods listed below.    You can order using either your MC, VISA, Amex, or Discover card.    The product 
ID # for OOG is 14735.    PsL will notify us the day of your order and we will mail your user name and 
serial number to you within 24 hours.

Telephone: (800)2424-PsL or (713)524-6394
FAX Orders: (713)524-6398
CIS Email: 71355,470
Post Office: P.O. Box 35705, Houston, TX 77235-5705

THE ABOVE TELEPHONE NUMBERS ARE FOR CREDIT CARD ORDERS ONLY.
THE AUTHOR OF THIS PROGRAM CANNOT BE REACHED AT THESE NUMBERS.

Any questions about the status of the shipment of the order, refunds, registration options, product details, 
technical support, volume discounts, dealer pricing, site licenses, non-credit card orders, etc, must be 
directed to MCM Productions at P.O. Box 30404, Alexandria, VA 22310 or via email at 
70742.2337@compuserve.com.

Related Links
The Concept of Shareware
What are the Benefits of Registering ?



Registration Form
(Print this form by selecting "Print Topic" from the "File" menu.)

OOG, The Object Orientation Game
Order Form

Version 1.1, July 07, 1996

Company Name: ________________________________________________

Your Name: ________________________________________________

Street Address: ________________________________________________

City, State, Zip Code: ________________________________________________

Country: ________________________________________________

E-mail Address: ________________________________________________

==============================================================

Register OOG for each machine on which the program is to be used.    Enclose $19.95
in US funds for each copy.    Educational institutions or anyone ordering more than 5
copies of OOG, please contact MCM Productions for site license pricing information.

OOG, The Object Orientation Game ________ copies at $19.95 each = ________

Virginia residents please add 4.5% sales tax + ________

Total Payment = ________

Payment must be in US dollars drawn on a US bank, or you can send an international
postal money orders in US dollars.    Send this form along with your payment to:

MCM Productions
P.O. Box 30404
Alexandria, VA 22310

==============================================================

Where did you get your copy of OOG ?    Which Web or FTP site ?    If downloaded from
one of the major online services such as AOL or CIS, from which area ?

______________________________________________________________________

How did you hear about OOG ?

______________________________________________________________________

What factors lead you to purchase OOG ?

______________________________________________________________________



Technical Support Policy
MCM Productions offers free, unlimited technical support to all users of OOG.    If at any time you 
experience any problem of any kind with your version of OOG, please contact us and we will do our best 
to quickly solve your problem.    However, registered users will receive priority support over unregistered, 
shareware users.    Technical support is provided via Internet/CompuServe e-mail or via the US postal 
service.

More Information
Ombudsman Statement
Revision History
Algorithm Notes
How to Become a Registered User



Ombudsman Statement
The ASP Board has set up an office of Ombudsman and appointed an ASP member as Ombudsman. The
Ombudsman's sole role is to mediate disputes between ASP members and their customers. The 
Ombudsman reports to the Board situations where s/he feels Board action or knowledge is appropriate.

All ASP Members and Associate Members are required to cooperate with the Ombudsman when so 
requested.

"This program is produced by a member of the Association of Shareware Professionals (ASP).    ASP 
wants to make sure that the shareware principle works for you.    If you are unable to resolve a shareware-
related problem with an ASP member by contacting the member directly, ASP may be able to help. The 
ASP Ombudsman can help you resolve a dispute or problem with an ASP member, but does not provide 
technical support for members' products. Please write to the ASP Ombudsman at 545 Grover Road, 
Muskegon, MI 49442-9427 USA, FAX 616-788-2765 or send a CompuServe message via CompuServe 
Mail to ASP Ombudsman 70007,3536."

More Information
Technical Support Policy
Contacting MCM Productions
Association of Shareware Professionals (ASP)



Revision History
The following list details the revision history of OOG.    The release information shown below is listed in 
reverse chronological order and is in no way meant to be a comprehensive listing of all the changes that 
occur between releases of this product.    MCM Productions makes no claims to the accuracy or 
completeness of this revision history.    Please read the What's New page for a more detailed description 
of the changes in the release of OOG.

Technical Support Policy
Algorithm Notes

---------------------------------------------------------------
Version #: 1.1
Release Date: July 07, 1996
Major Changes, Fixes & Enhancements:

· To allow users time to admire their solutions, a mouse click is now required after solving a puzzle.
· Added game setup dialog box for maintaining options for each puzzle game separately.
· Added more puzzles to each of the four polyforms.
· Corrected bugs in the solution detection algorithm.
· Corrected bugs in the algorithm used to build puzzle outlines from user created puzzles.
· Corrected bugs in detecting solutions for Tangrams puzzles #48, #137 and #138.
· Implemented a new configurable method for performing shape rotations using a single button click.
· Added real descriptions for over 35 Tangrams puzzles (replacing the old text of "Anonymous").
· Corrected "skewed corner" problem with Tangrams puzzle #78.
· Implemented code to track the shareware evaluation period.
· Added a Puzzle Statistics dialog box available from the Options menu.
· Added a Delete Player button to the New Player dialog box.
· Changed the method used to display the "solve status" of a puzzle in the By Picture dialog box.
· Added statements regarding membership in the Association of Shareware Professionals.
· Updated default game piece positions for Pentominoes such that all are orthogonal.
· Added an option to prevent the snapping of game pieces to the puzzle outline.
· Added file preview window to the load puzzle and restore layout dialog boxes.

---------------------------------------------------------------
Version #: 1.0
Release Date: September 18, 1995
Major Changes, Fixes & Enhancements:

· Initial public release.



Algorithm Notes
The following notes discuss certain aspects of some of the more complex algorithms found in OOG.    
Each of these algorithms has been thoroughly tested and to the best of our knowledge work correctly.    
However due to their complexity, it is possible you may encounter a situation in which an algorithm does 
not perform as intended.    The purpose of this page is to highlight areas where we feel it is possible this 
might occur.    If you are experiencing any strange problems with OOG, check this list to see if the issue is 
discussed.    Refer to the revision history for a description of the changes implemented between releases 
of this product.

Building Puzzle Outlines from User Created Puzzles
Whenever OOG loads a user created puzzle from disk, an algorithm is invoked to find the outer edges of 
the puzzle outline.    This outline is what gets displayed over the background when you are solving 
puzzles.    This algorithm is fairly complex and every care has been taken to ensure it performs as 
intended.    However it is possible you may encounter a puzzle that the algorithm can not handle properly. 
If a problem does occur, you will encounter one of the following two cases.

1) The program will report that it could not build the outline for the selected puzzle and will simply display 
each piece of the puzzle in its original form thereby giving away the solution.    We realize giving away the 
solution to a puzzle is a bummer, but we felt it was much better than crashing or hanging the program or 
computer.

2) The algorithm will appear to have performed correctly but the displayed puzzle outline will be incorrect. 
Unless you know what the puzzle outline should look like, you will probably have no idea that anything is 
wrong.    You may eventually realize there is a problem if the puzzle can not be solved or if you've solved 
the puzzle but OOG isn't recognizing your solution.

Detecting Solutions To Puzzles
The algorithm used to automatically detect when you've found any solution to a puzzle is in our opinion 
very trustworthy.    We don't expect OOG to incorrectly report a puzzle as being solved when in fact it is 
not.    Conversely, we don't expect it to ignore and not recognize a puzzle as being solved.    However it is 
possible you may encounter a situation where this algorithm performs unexpectedly.

What To Do
If you encounter any of these situations, we'd really like to know about it.    This is not a challenge for 
everyone to try and break these algorithms, nor is there a reward if you do.    But if you'd drop us an e-
mail and let us know about it, we'd really appreciate it.



About MCM Productions

Hello!    Thank you for taking the time to download and try OOG !    To answer your first question: The 
MCM stands for Mr. Confetti Man™, the company mascot pictured above and on the OOG startup splash 
screen.

MCM Productions is dedicated to developing high-quality Windows applications.    OOG is our first publicly
released application and we hope you find it entertaining and easy-to-use.    Whether or not you decide to 
become a registered user of OOG, feel free to send us your comments and suggestions.    We are as 
open and responsive to corrective criticism as we are to compliments.    Please don't hesitate to contact 
us or visit our Web site where we have links to other game and puzzle sites on the Internet.

MCM Productions is an Author Member of the Association of Shareware Professionals.



Contacting MCM Productions
E-mail Addresses:

CompuServe: 70742,2337
Internet: confetti@crosslink.net

World Wide Web Site:

http://www.mcmprod.com/

FTP Site:

ftp://www.mcmprod.com/users/c/confetti

Postal Service:

MCM Productions
P.O. Box 30404
Alexandria, VA 22310



Association of Shareware Professionals

The Association of Shareware Professionals (ASP) is an association for shareware authors and 
distributors with the general goals of educating shareware authors and distributors and the public, setting 
standards and sharing resources and information among members.

If you are interested in becoming a member of the Association of Shareware Professionals, contact their 
Executive Director at one of the addresses below for a membership kit.

Postal Address
Executive Director
Association of Shareware Professionals
545 Grover Road
Muskegon, MI 49442-9427
Phone: (616)788-5131

CompuServe PPN: 72050,1433

Visit their CompuServe Forum: CIS:ASPFORUM

On the Web: http://www.asp-shareware.org/
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License Agreement
THIS PROGRAM IS LICENSED TO YOU ONLY UPON THE TERMS AND CONDITIONS LISTED 
BELOW.    IF YOU DO NOT ACCEPT SUCH TERMS AND CONDITIONS, YOU MUST ERASE ALL 
COPIES OF THIS PROGRAM AND ALL ASSOCIATED FILES FROM YOUR SYSTEM AND/OR OTHER 
STORAGE MEDIA.

TRIAL USE LICENSE
OOG, The Object Orientation Game is NOT a public domain program.    It is a program being distributed 
as shareware and is provided at no charge to the user for evaluation.    It is copyrighted by MCM 
Productions.    This software and accompanying documentation are protected by United States copyright 
law and also by international treaty provisions.

MCM Productions grants you a limited license to use this software for evaluation purposes for a period of 
30 days AND 30 executions.    After both 30 days AND 30 uses have been exhausted, your evaluation 
period is over.    If you continue using this software after the evaluation period has expired, you MUST 
make a registration payment to MCM Productions.

In no event may you install OOG, The Object Orientation Game for use on a network.    You may not 
modify, disassemble, decompile or otherwise reverse engineer OOG, The Object Orientation Game.    You
may not rent or lease OOG, The Object Orientation Game.    You may copy OOG, The Object Orientation 
Game for backup purposes in anticipation that the original copy may become corrupted.    In no event 
shall you remove or alter any copyright, trademark or other notice included with the shareware or 
registered version of OOG, The Object Orientation Game.    Any such unauthorized use shall result in 
immediate and automatic termination of this license.    All rights not expressly granted here are reserved to
MCM Productions.

LIMITED DISTRIBUTION LICENSE
Distributors recognized by the ASP as adhering to its guidelines for shareware distributors may distribute 
OOG, The Object Orientation Game, completely unaltered, without further permission.    For other cases 
or to distribute in modified form, you must consult the attached data record, which is hereby incorporated 
by reference.    Any distribution satisfying all the distribution requirements expressed in that data record is 
hereby authorized.    We recommend that anyone distributing OOG, The Object Orientation Game advise 
MCM Productions so that the distributor can be kept up-to-date with the latest version.

Permission to distribute the OOG, The Object Orientation Game package is not transferable, assignable, 
saleable, or franchisable.    Each vendor wishing to distribute the package must independently satisfy the 
terms of this limited distribution license.

MCM Productions may revoke any permissions granted here, by notifying you in writing.    All rights not 
expressly granted here are reserved to MCM Productions.

More Important Information
Contacting MCM Productions
The Shareware Concept
The Benefits of Registering OOG
How to Register OOG
Association of Shareware Professionals (ASP)



Warranty Disclaimer
MCM PRODUCTIONS DISCLAIMS ALL WARRANTIES RELATING TO THIS SOFTWARE, WHETHER 
EXPRESSED OR IMPLIED, INCLUDING BUT NOT LIMITED TO ANY IMPLIED WARRANTIES OF 
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE, AND ALL SUCH WARRANTIES 
ARE EXPRESSLY AND SPECIFICALLY DISCLAIMED.    NEITHER MCM PRODUCTIONS NOR 
ANYONE ELSE WHO HAS BEEN INVOLVED IN THE CREATION, PRODUCTION, OR DELIVERY OF 
THIS SOFTWARE SHALL BE LIABLE FOR ANY INDIRECT, CONSEQUENTIAL, OR INCIDENTAL 
DAMAGES ARISING OUT OF THE USE OR INABILITY TO USE SUCH SOFTWARE EVEN IF MCM 
PRODUCTIONS HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES OR CLAIMS.    IN 
NO EVENT SHALL MCM PRODUCTIONS' LIABILITY FOR ANY DAMAGES EVER EXCEED THE PRICE
PAID FOR THE LICENSE TO USE THE SOFTWARE, REGARDLESS OF THE FORM OF CLAIM.    THE 
PERSON USING THE SOFTWARE BEARS ALL RISK AS TO THE QUALITY AND PERFORMANCE OF 
THE SOFTWARE.

SOME STATES DO NOT ALLOW THE EXCLUSION OF THE LIMIT OF LIABILITY FOR 
CONSEQUENTIAL OR INCIDENTAL DAMAGES, SO THE ABOVE LIMITATION MAY NOT APPLY TO 
YOU.

THIS AGREEMENT SHALL BE GOVERNED BY THE LAWS OF THE STATE OF VIRGINIA AND SHALL 
INURE TO THE BENEFIT OF MCM PRODUCTIONS AND ANY SUCCESSORS, ADMINISTRATORS, 
HEIRS, AND ASSIGNS.    ANY ACTION OR PROCEEDING BROUGHT BY EITHER PARTY AGAINST 
THE OTHER ARISING OUT OF OR RELATED TO THIS AGREEMENT SHALL BE BROUGHT ONLY IN A
STATE OR FEDERAL COURT OF COMPETENT JURISDICTION LOCATED IN FAIRFAX COUNTY, 
VIRGINIA.    THE PARTIES HEREBY CONSENT TO IN PERSONAM JURISDICTION OF SAID COURTS.



Trademarks
Mr. Confetti Man, the MCM logo and likenesses are all trademarks of MCM Productions.    All companies, 
product names and services identified in this help file and elsewhere are trademarks, service marks, or 
registered trademarks of their respective companies.



Operation Not Available
This dialog box is presented whenever you attempt to perform an action that is not available in the 
shareware version of OOG.    The title of the displayed message box indicates the operation that failed to 
be performed.    Inorder to use these functions, you must register your shareware version of OOG with 
MCM Productions.

What is Shareware ?
What are the Benefits of Registering ?
How do I Register OOG ?



Error Messages

Warning!!!
The displaying of any message box that causes you to reach this page, after pressing the 'F1' key, 
indicates that your version of OOG is most likely corrupt.    These message boxes indicate that OOG has 
detected a fatal error with its internal data.    These errors should not occur under normal circumstances.

If you receive one of these message boxes, we strongly suggest you contact MCM Productions to obtain 
the latest version of OOG.



This window allows you to see the definitions of various terms used throughout the OOG help system.    
For more detailed information on an item, refer back to the help system.

game pieces
layout file
player progress tracking
polyform puzzle
puzzle outline
puzzle file
quick-click menu
registration
shapes
shape maneuver operations
shareware
snapping
title window



The game pieces, or shapes, are the items you must move, rotate, and flip to completely overlay the 
displayed puzzle outline, without having any overlap among the pieces, in order to solve the polyform 
puzzle.    We have a bad habit of using the terms game pieces and shapes interchangeably.



A layout file describes the position and orientation of all the game pieces for a given polyform.    A layout 
file is used to save your progress on a puzzle so you can restore it at a later time and give the puzzle 
another try.    It can also be used to save a solution's layout after you've solved a puzzle and for saving 
your progess on a puzzle you are creating.



The player progress tracking feature gives OOG the ability to remember which puzzles a player has 
solved for a particular polyform.    Whenever you play, a database is being maintained that stores which 
puzzles have been solved for the current polyform.    When you solve a puzzle, the database is updated to
identify that that particular puzzle has been solved.



The tiling puzzle games found in OOG are more commonly referred to as polyform puzzles by puzzle 
enthusiasts.    The goal of a polyform puzzle is rather simple to understand.    Your goal is to arrange a 
given set of shapes, or game pieces, to completely overlay, or cover, a given puzzle outline.    The 
resulting solution must not and will not contain any overlap amongst the shapes.    Note that many 
polyform puzzles have more than one solution.



The puzzle outline is the pattern(s) you are trying to duplicate with the given set of game pieces.    It is the 
colored item(s) in the OOG window that you can't manipulate with the mouse.    When you've duplicated 
the displayed pattern(s) using the given shapes, you've solved the puzzle!



A puzzle file describes a puzzle outline and contains the necessary information for OOG to give hints for 
and show the solution to the puzzle stored in that file.    A puzzle file is created whenever you create your 
own puzzles with OOG and save them to disk.    These files can then be loaded into OOG and played like 
the built-in puzzles.



This menu is simply a popup shortcut menu that is displayed whenever you click and hold down the right 
mouse button over the main window background when you are creating a puzzle.



Registration is the process by which you purchase OOG.    After your registration is processed, you will be
sent a user name and serial number that when entered into the OOG Registration dialog box will give you
complete access to the registered version of OOG.



The shapes, or game pieces, are the items you must move, rotate, and flip to completely overlay the 
displayed puzzle outline, without having any overlap among the shapes, in order to solve the puzzle.    We
have a habit of using the terms shapes and game pieces interchangeably.



These are the operations you perform on the game pieces in order to solve the polyform puzzle.    They 
are move, rotate and flip. All are performed using simple mouse operations.    See the How to Play section
of the help file for more information.



Shareware is a marketing concept that allows you, the potential buyer, to evaluate a piece of software 
before you are required to pay for it.    A shareware author,    the seller, trusts you to pay for, or register, the
program if you continue to use it beyond the stipulated evaluation period.

OOG is a shareware program.    It is a complete, fully functional application.    You will be able to fully 
evaluate every feature available in OOG using the shareware version.    You may use it for 30 days AND 
run it 30 times for evaluation purposes.    If you find it useful and continue to use it beyond this evaluation 
period, you are legally bound to register and pay for your copy.



Snapping is the catch-phrase used to describe the operation performed by the auto-shape alignment 
algorithm in OOG.    The snapping algorithm is invoked at the conclusion of every shape maneuver 
operation (i.e. move, rotate or flip) and determines the intended location of the shape relative to any of its 
neighboring shapes or the puzzle outline.    Once the algorithm has determined the intended location of 
the shape, it snaps the shape to that location thereby freeing the player from having to worry about 
perfectly aligning and connecting the pieces together.



The title window is the rectangular area directly below the menu bar that displays a block of text detailing 
information about the current puzzle being solved.    The text has the following format:

# # # - T T T - X

The "# # #" is the internal number assigned to the puzzle. The "T T T" is the assigned title or description 
for the puzzle and the "X" indicates whether or not the puzzle has been solved according to information 
found in the player progress tracking database.    The "X" is replaced with a "U" if the puzzle is unsolved 
and an "S" if the puzzle is solved.    If you are solving a puzzle loaded from disk, the text will only contain 
the puzzle's assigned title or description.    This area is also used by OOG for displaying various 
messages.






